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DATABASE

You have studied in the previous class that database is a collection of data which is organized 
in a manner that can be easily retrieved. They consist of fields, records and files.

The software that is used to access, release, modify, delete, search, sort, design and print 
data is called Database Management System (DBMS). Using DBMS the data redundancy, 
inconsistency and duplication can be reduced and the security and integrity of data can also 
be maintained. The main function of a DBMS is to :

•	 Organize the data.

•	 Control how and where the data is to be stored.

•	 Modify and update the data.

•	 Access the data quickly and easily.

•	 Protect and secure the data.

MS ACCESS

With the increasing demand for Windows Application Microsoft Company 
introduced a Relational Database Management System (RDBMS) for 
the Windows platform called MS Access. In a manual database, you 
might record data on paper and store it in a filing cabinet. Database 
software, like Access, is a software that allows you to create, access 
and manage a database.

MS Access comes packed with features and tools that are easy to use 
by the beginners.

Microsoft Access is a program for creating databases to store business 
or personal data. You can use Access to manage large or small collections 
of information. The information can be viewed, sorted, manipulated, retrieved and printed in 
various ways. Access gives you the flexibility to obtain this data in multiple formats.

Tables in  
MS Access 2010

In this chapter, you will learn about :
• Introduction to MS Access • Defining database • Tables in database

• Starting Access 2010 • Creating a New Table in Datasheet View

• Field Properties • Adding Records to a Table • Saving and Closing a Table

4



39 Computer-8

If a Security 
Warning Bar 

appears

Relational Database

Microsoft Access creates relational databases. Relational database can contain multiple tables 
with links between them. For example, a school may have a students table for storing student 
contact information and a result table for storing information about marks of the students. 
Each student in the Students table has a unique ID, and each result in the results table 
references a specific student ID.

Tables, Records, and Fields

Access stores the data in tables. Each individual entry in the table is called  a record. For 
example, in a Students table, the information about each student is a separate record. Each 
record is composed of one or more fields that contain individual pieces of data. For example, 
Student fields may include Roll number, Name, Address and Class.

OPENING  A DATABASE FILE

You can open a database that you previously created to continue entering data into it.

Step 1	:	 Click on the File tab.

		  The backstage view appears.

Step 2	:	 Click on Open.

		  Alternatively, you can press 
Ctrl + O instead of performing.

		  The Open dialog box will 
appear.

Step 3	:	 You can click here and navigate to a different 
location.

Step 4	:	 Click on the name of the file that you want to 
open.

Step 5	:	 Click on Open.

Step 6	:	 Click on the Enable content.
		  The database file opens.
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CHANGING THE NAVIGATION PANE VIEW

You can display or hide the Navigation pane which is situated on the left side of Access 
window. The Navigation pane enables you to view database objects like tables, queries, reports 
and forms.

•	 You can also press F11 toggle key from keyboard to display or hide the Navigation pane.

CREATING A NEW TABLE IN DATASHEET VIEW

You can create a table from Datasheet View and then add new fields simply by typing the field 
names into the column-heading placeholders. Datasheet View is good when you need a quick 
table consisting of just a few fields. The steps to create a table using Datasheet View are :

Step 1	:	 Click on the Create tab 
on the Ribbon.

Step 2	:	 Click on the Table 
button.

		  Access opens a new table 
in Datasheet view.

Step 3	:	 Double-click the column 
header to create a field 
name.

Step 4	 :	 Type a name for the field.

Step 5	:	 Press Enter key from the keyboard.

Step 6	:	 Click on the next 
column.

		  Data Type menu will 
appear.

Step 7	:	 Select the data type for 
the field, e.g., select 
Text, if you want to add 
the Name of the field.

Step 8	:	 Type a name for the 
field.

A security warning appears when you are opening a database that is stored in a location 
that is not trused, such as a file you received as an e-mail attachment, or when opening 
a file that  contains macros (sets of recorded actions). The message implies that the file 
contains dangerous content, but that is not necessarily so; even a blank database can 
trigger this warning.

Know 
More
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Step 9	:	 Repeat the steps to 
create more fields for 
the table.

Step 10:	Click inside the first 
field of the first row 
and type the data to 
enter the first record.

Step 11:	Press Tab key.

Step 12:	Type the next field’s 
data.

		  Repeat the steps to 
complete the record.

When you reach the last field, 
you can press Enter to start a 
new record.

You can resize a column by dragging the column 
border left or right.

CREATING A NEW TABLE IN DESIGN VIEW

You can create a new table in Design View to get the exact fields that you want. In Design 
View the Window is divided into two panes: top pane for creating field name, specify field 
types, and enter field descriptions and bottom pane for specifying field properties.

For each field, you have to indicate the following :

Field Name : It contains the name of field that represents the contents of the field such as  
‘Name’, ‘Address’, ‘City’, etc. Each field name should have a unique name and cannot exceed 64 
characters in length.

Data Type : Each field has a data type that defines what you can store in it. Data entry is 
restricted to valid entries for the type you choose, which helps to prevent data-entry errors. 
For example, you cannot enter letters in a field set to Number, and you must enter valid dates 
or times in a Date/Time field.

•	 Text : This is a general-purpose field containing any data. It has a limit of 255 characters 
and cannot be used for numeric calculation. Use this type for numeric entries that will not 
have calculations performed on them, such as telephone numbers and ZIP codes.

•	 Memo : This type has a limit of 63,999 characters; used for detailed, descriptive fields.

•	 Number : This type stores numeric data that you can use in calculations. It can also hold 
symbols, such as decimal points and commas.

•	 Date/Time : This type only stores numbers representing valid dates and times.

•	 Currency : Stores currency data that you can use in calculations.

•	 Auto Number : Stores a sequential number for each record.
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•	 Yes/No : The value =1 represents Yes, and the value = 0 represents No, but the field can be 
formatted to display values as True/False or Yes/No.

•	 OLE Object : Stores objects created in another application such as Word or Excel that you 
can link to or fix in an Access table.

•	 Hyperlink : You can link to Websites, e-mail addresses, files on your computer, files on a 
LAN, or virtually any other location.

•	 Lookup Wizard : Depending on the usage, this type creates either a lookup list from data 
that you specify or a lookup list from the values in another table. It can also be used to 
set up multiualve lists.

•	 Attachment : This type works only in Access 2007 and Access 2010 databases. You can 
attach data files from word-processing programs, spreadsheets, graphic editing programs, 
and so on.

•	 Calculated : This field type is new in Access 2010. You can use it to create calculated fields 
directly in a table; in earlier versions, you could create calculated fields only in queries.

Description : You can enter a detailed description of the field in Access.

Step 1	:	 Open the database and click 
on Create tab on the Ribbon.

Step 2	:	 Click on the Table Design 
button.

		  The table window appears.

Step 3	:	 In the Field Name column, type the name of the first field (Customer_ID).

Pane in which fields 
are created

Field name 
column

Data type 
column

Description 
column

Pane in which 
field properties are 

specified
Pressing F6 switches 

between panes
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Step 4	:	 Press the Tab key to bring 
the Insertion point to the 
Data type field.

Step 5	:	 If you want to change the 
data type, click on the 
arrow button and change 
the data type according to 
your need.

The words, Customer-ID display in the 
Field Name column and the insertion 

point advances to the Data Type 
column, indicating you can enter the 

data type. The word, Text, one of 
the possible data types is currently 

displayed.

Step 6	:	 Press the Tab key to move 
the insertion point to the 
Description column.

Step 7	:	 Type your text as the 
description in Description 
column.

After selecting the data type its properties 
will be displayed in the lower pane.

Step 8	:	 Press the Tab key again to 
move to the Field Name 
column in the second 
row.

Step 9	:	 Type the text (Customer 
Name) in Field Name 
column.
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Step 10	:	Press the Tab key to move 
to the Data Type column.

Step 11	:	Press the Tab key to move 
the insertion point to 
Description column, if 
you want the Data Type 
as Text.

Step 12	:	Type the text for the 
Description column.

Step 13	:	Repeat the steps to make 
the remaining entries in the 
table to complete it.

SETTING A PRIMARY KEY

A Primary key is a key that 
differentiates the records in a file. It 
is fairly simple to set a primary key. A 
primary key is not required for every 
table, but it is highly recommended.

If you save or close a table without 
setting a primary key, Access displays 
a warning dialog box.

The word ‘Text’ is currently displayed in the field

Step 1	:	 Choose the field that you want 
to set as the primary key.

Step 2	:	 Click on the Primary key 
button.

The Primary key is a toggle key. To 
remove it, select the primary key field 
and click on the Primary key button 
again.
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SAVING A TABLE

After creating a new table, you must 
save the table to make it a permanent 
part of the Database. When you save a 
table, you give it a name.

Step 1	:	 Right-click on the table’s 
tab.

Step 2	:	 Click on Save.

		  The Save As dialog box 
opens.

Step 3	:	 Type a name for the table.

Step 4	:	 Click on OK.

The Primary key appears in the field 
indicating by a small key in the field of 

selector column.

The table remains 
open, and its new 

name appears on its 
tab.

Step 1	:	 Click the selector to the 
left of the field name.

REARRANGING THE FIELDS

The Fields can be rearranged in the table. The field order 
in Design View from top to bottom corresponds to the 
order in a datasheet from left to right.



46 Computer-8

Step 2	:	 Drag up or down the mouse 
pointer on the selector to 
move the field.

Step 3	:	 Repeat the steps to move 
other fields as needed.

INSERTING AND DELETING THE FIELDS

You can insert new and remove existing fields into a field list. A new row appears in the grid—
above the you have selected.

Insert a Field

Step 1	:	 Select the field where you want new field should appear above.

Step 2	:	 Click on the Design tab.

Step 3	:	 Click on the Insert Rows.
Step 4	:	 Type a field name and choose a 

field type.

Delete a Field

Step 1	:	 Select the field that you want to 
delete.

Step 2	:	 Click on the Design tab.

Step 3	:	 Click on the Delete Rows.
		  The row will be deleted, along with 

any data that the fields have.

CHANGING THE DATA TYPE

You can change a field’s data type anytime to better represent your data. You should set the 
field type before you enter data into the table, but if the change is required, you can change 
the field type at any time.

Step 1	:	 Click on the down arrow to open the 
Data Type list for the field.

Step 2	:	 Click on new type.
		  The type changes in the Data Type 

column.
Step 3	:	 To save the changes to the table, click 

on Save button on the Quick Access 
Toolbar.

		  A warning message may appear.

A horizontal line shows were the field is going.
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Step 4	:	 Click on Yes to allow the deletion of records that violate the new field type’s rules.

		  You can also click on No to abandon the change.

RENAMING A TABLE

You can rename a table at any time. Access 
automatically updates all references to the 
table throughout the database, so any forms, 
reports, or queries based on that table continue 
to work. The table must be closed in order for 
you to rename it.

Step 1	:	 Right-click on the table name in the 
Navigation pane.

		  A short-cut menu appears.

Step 2	:	 Choose Rename from the shortcut 
menu.

		  The table name appears in Edit 
mode.

Step 3	:	 Type the new name for the table and 
press Enter key from the keyboard.

UNDERSTANDING FIELD PROPERTIES

Each field has a property which is set from the bottom pane of the Design View window. The 
properties include the basics such as field size, format and also the rules for entries in it.

•	 Properties pane : When a field is selected on Design view, its properties appear in lower 
pane.

•	 General tab : The General tab contains most of the properties you will work with.

The new name appears on the table.

Properties Pane

General Tab Lookup Tab

Dropdown list

Property information

Yes/No 
Properties

•	 Lookup tab : The Lookup 
tab is primarily for 
setting up lookup lists.

•	 Drop-down lists : Some 
properties have drop-
down lists from which 
you can select; click the 
arrow to open the list.

•	 Property information : When the insertion point is in a property’s box, information about 
that property appears here.
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•	 Yes/No properties : Some properties represent yes/no questions; these are already typically 
filled in for you with default values.

Understanding Field Sizes

Each field has a size that limits the amount of data you can store in it. Because there are 
different types of fields so there are different ways of expressing the field size depending on 
the type of field.

Field Type Field Size Meaning
Text 255 You can specify any number of characters from 0 to 255.
Number Long Integer Byte, Integer, Long Integer, Single, Double, Replication ID, 

Decimal
Auto Number Long Integer The same as Number, except there are only two choices : Long 

Integer or Replication ID

CHANGING THE FIELD SIZE

You can change the Field Size according to the need of your database.

Text Number Auto Number

For the Text Data Type

Step 1	:	 Click on the field whose size 
you want to change.

Step 2	:	 Click on the General tab in the 
Field Properties area.

Step 3	:	 Enter the new field size in the 
Field Size text box.

For the Number Data type

Step 1	:	 Click on the field whose size 
you want to change.
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Step 2	:	 Click on the General tab in the Field 
Properties area.

Step 3	:	 Click in the Field Size row.

		  A drop-down menu arrow appears on 
the row.

Step 4	:	 Click on the drop-down menu arrow 
to choose the field size that you 
want.

SET THE FIELD CAPTION

You can specify captions for fields that are 
different from their actual names. Captions 
appear in datasheet headings and on labels 
in forms and reports.

Step 1	:	 Click on the field whose caption you 
want to change in Design View.

Step 2	:	 Click on the General tab in the Field 
Properties area.

Step 3	:	 Click on the Caption row and type a 
caption.

Step 4	:	 Click on the Save button in the 
Quick Access Toolbar.

SETTING THE FIELD’S FORMAT

You can change a field’s format to update its appearance in datasheets, forms, and reports.

Step 1	:	 Click on the field whose format you want to change.

Step 2	:	 Click on the General tab in the Field Properties area.

Step 3	:	 Click on the Format row.

Step 4	:	 A drop-down menu arrow appears 
on the row.

Step 5	:	 Click the drop-down menu arrow to 
choose the format that you want.

•	 For a Number or AutoNumber field, the 
choices represent different number types, 
such as General, Currency, and Percentage.

•	 For Date/Time data types, the choices 
appear as date/time formats.
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•	 For Yes/No fields, the choices appear as ways of expressing yes or no.

SETTING A DEFAULT VALUE

If you have a field that usually contains 
the same value, you can make that value as 
default for that field. For example, if your 
customer pays the amount by cash you can 
make Cash the default value in the Payment 
Mode field.

Step 1	:	 Click on the field whose default 
value you want to set.

Step 2	:	 Click on the General tab in the 
Field Properties area.

Step 3	:	 Click on the Default Value row.

Step 4	:	 Type the default value.

		  Access automatically adds quotation 
marks around what you have typed 
if the field type is Text.

CREATING VALIDATION RULES

Validation Rule is used to force a field entry 
to meet a logical test of its validity. By 
Validation Rules, you can ensure that the 
correct value is entered in the field. If the 
user makes an incorrect entry, Error alerts 
can stop the user, provide a warning or just 
provide information.

Step 1	:	 Click on the field where you want 
to create validation rule.

Step 2	:	 Click on the General tab in the 
Field Properties area.

When you display the table’s datasheet, the default 
value appears in new records.

In the datasheet view, if you enter a wrong entry 
or violate the rule, a custom error message appears, 
containing the text you specified in the Validation 

Text row.

Step 3	:	 Click in the Validation Rule row and 
type the Validation Rule in that row.
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Step 4	:	 Click in the Validation Text row and type the text for the error message.

Step 5	:	 Click on OK, then retype the field entry.

ADDING RECORDS TO A TABLE

Now the next step is to add records to the table 
after creating the database. The table must be 
open so that the records can be added to the 
table. The table is opened in datasheet view, 
which represents as a collection of rows and 
columns. The steps to add records to a table 
are :

Step 1	:	 Double-click on the Table (Customer 
Table) in the Customer Database window.

		  You can close the Navigation Pane for more space.

Fields name

Datasheet view

Customar Table : Table Window

Record 1 is Current Record

Description of the First Field

Type the following entries by pressing the 
Tab key after each one to complete the 

record.

Step 2	:	 Type the Customer ID in 
the first Customer_ID field.

Step 3	:	 Press the Tab key to 
complete the entry for the 
Customer ID field.
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Step 4	:	 After typing the last 
entry, e.g. Mode, press 
the Tab key.

The insertion Point comes to the 
Customer ID field in the second 

row.

Step 5	:	 Add the remaining 
records by following the 
same steps you used to 
add the first record, as 
in the steps. 

Step 6	:	 When you finish 
entering the data, 
click on the Save 
button to save the 
changes.

Access Save the table and you 
can see the name of the table in 

Navigational pane.
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CLOSING DATABASE

After finishing your work, you can close a database without closing Access 2010. In Access, 
you can open many databases at the same time. Closing a database free’s up your computer’s 
memory.

Step 1	:	 Click on File.

		  File menu will open.

Step 2	:	 Click on Close Database.

		  The File menu stays open, and 
the New command becomes 
selected.

Points to Remember
•	 Access is a relational database management system that can store large quantities of 

information.
•	 DBMS is a software used to access, retrieve, delete, search, sort, design and print data.
•	 In design view, the data field in the table is defined before adding any data to the datasheet.
•	 Each field name in a table should have a unique name.
•	 The default field size for the text type data is upto 255 characters.
•	 A new record to the table in datasheet can be added by opening a table.
•	 After completing the table structure, the database must be saved.
•	 A Primary key is a key that differentiates the records in a file.
•	 Data entry is restricted to valid entries for the type you choose, which helps to prevent data-

entry errors.

A.	  Tick (4) the correct option :

	 1.	 Access stores data in :

	 (a)	 fields	 	 (b)	 table	 	 (c)	 file	

	 2.	 Each entry in the table is called :

	 (a)	 record	 	 (b)	 data	 	 (c)	 value	

	 3.	 Default extension of database file :

	 (a)	 .accbd	 	 (b)	 .abcde	 	 (c)	 .accdb	

	 4.	 The key presses to move from upper pane to lower pane :

	 (a)	 F8	 	 (b)	 F1	 	 (c)	 F6	
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B. 	 Fill in the blanks : 
	 1.	 _____________ is a collection of data organized in a proper manner.
	 2.	 _____________ database can contain _____________ tables with links between them.
	 3.	 Access stores the data in _____________.
	 4.	 Each individual entry in the table is called a _____________.
	 5.	 A _____________ key is a key that differentiates the records in a file.

C. 	 Write (T) for true and (F) for false statements : 

	 1.	 Access is a software that allows you to create access and manage a database.	

	 2.	 You can use Access to manage large or small collections of information.	

	 3.	 To starting Access 2010, click on the Blank database option. 	

	 4.	 The Navigation pane displays the database objects that you create, such as tables	  
and forms.	

	 5.	 After completing the table structure, the database must be saved.	

D. 	 Answer the following questions :

	 1.	 How do you create validation Rule?
	 2.	 What is MS Access?
	 3.	 What are the main functions of DBMS?
	 4.	 What are field properties?
	 5.	 Define primary key. Why do we need the primary key?
	 6.	 What do you know about Auto Number?
	 7.	 What is Primary Key?
	 8.	 What is Property information?
	 9.	 What is field size of text?
	 10.	 Write a short note on MS Access.

ACTIVITY

	 •	 Create a new database as ‘Profile’.

	 •	 Now create a table that contains the following fields in it :

	   First Name, Last Name, Date of Birth, Address, Telephone, Qualification, Vehicle.
	 •	 Save the table as ‘Contacts’.

	 •	 Add the suitable Data type and description for each field name.

	 •	 Select ‘First Name’ as the primary key field.

	 •	 Now enter the 20 records in the table.

	 •	 Add another field name ‘E-mail’ before Qualification field and update the records 
accordingly.

	 •	 Close the Database and MS Access.


